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& FEAEEAANMAME - B HRER KPS HE Y 55 8B BON
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A5 (EP201308184# H) » V yn KPS E e H A (= H F/20160206 %
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Geraldine Gebhart& ffi 8 £ (3 & Bordet Institute Brussels) /48 k&
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{5k 4T it T 5 A mT DL 55 58 A G S HE 5% B RS P 90 & S JEE {5 4] R 4 A% SE
t, w DL $8 7 DU B2 ) SR R SRR Al A o B F 20134 - HLAS IR R PR Y JE
FH 275 501 B PR Hi#S A1 R PR 5 Ba [ B - A 18{E #E FDA/EMAZF 1] » f1 45
L3{E AR HLAS @ BB VM E G S - DL 218 U e 6 B IS 52 il (3=
MU &T7) - i Rl B T B By SOfE B kR b S A 8(E R 2 B IS & 2 A -
B a8 22 2% R (4 0y BE AR DU dS A 1R 9 A0 Bk 75 Mk - /5 S/ i Bt / P
RN RIS - BEERRDURR T BB LIS - IR ABE R
F EEE AHEIE H (32 75) (Marleen Keyaerts, Catarina Xavier, Johannes
Heemskerk, Nick Devoogdt, Hendrik Everaert, Chloé Ackaert, Marian

Vanhoeij, Francois P. Duhoux, Thierry Gevaert, Philippe Simon, Denis
Schallier, Christel Fontaine, llse Vaneycken, Christian Vanhove, Jacques De
Greve, Jan Lamote, Vicky Caveliers, and Tony Lahoutte Phase | Study
of ®®Ga-HER2-Nanobody for PET/CT Assessment of HER2 Expression in
Breast Carcinoma. J Nucl Med 2016 57:27-33.)

Sture LindegrenZy 57 11~ 48 L ¥l alpha )& & (2K H #f B Gothenberg KX ) »
M8 LA BRZEEE 7L » HEBA2LUEGEIRE RN - Hipt

ERAZGRMAESE  HHANREEGRNEAEEE » IRH &I

A R 5 U7 0% 40 BT (e 11 -

FHERBERE K RERI6EME - 2AREEE > AL

MEE > BEERFEEFESFH > AT
1. What is the major toxicity-limiting organ for radiolabeled

small molecules? What are the mechanisms? Which


https://worldwide.espacenet.com/
http://www.google.com/patents

bioengineering and radiochemical solutions could you propose
to come up with a solution?

You have a nanobody produced with a hexa-histidine tag and
you want to label the protein without making any
modifications of the protein. Where can you label and which
isotope would you use? Explain.

Which biochemical reactions can you propose to conjugate a
bifunctional ligand to a nanobody? Which bifunctional ligand
would you choose for Ga-68?

After the selection and validation of a lead compound based
on preclinical experiment, which other steps are essential
before you can test this compound in a clinical study?

What are the major limitations of in vivo fluorescence
iImaging? What is the consequence for clinical translation?
What are the three types of irradiation that can be used for
targeted radionuclide therapy? Give examples and the

advantages/disadvantages of each application?

12 Z & HEBE R ESHMN TR > 43 5l2&Nick Devoogdt# #7 & 4=
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Catarina XavierZ % B L2 R th 2 o 82 52 - 15 7 tH I B & F A b
EREEE (LA Te-99m tricarbonyl method 5 (5] » A B A% 55 20 B A i B ol 45 ==
WIS $% — &) ; Sophie Hernot#(#% 2 £V TIRE % » E i mAaR
wOCAN AL 2 E A 5 Matthias D’HuyvetterZ 4% 2 £V TR 25 » f£ 74

2t 3 2

H o (5 el e 8 & e T B AR YR O A BOE (0 I B = &)

Marleen Keyaerts/2 & Hli > 1 57 2H 5 5 B 5 2 15 A Jig il 28 5 91 B4 [ 2
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Day | 09h00 - 09h15 | Welcome
1 09h15 - 10h45 | Lecture: Prof. Dr. Nick Devoogdt (VUB, Belgium) - Do’s and
don’ts in Immunotracer Design
10h45 - 11h00 | Coffee Break
11h00 - 12h30 | Lecture: Prof. Christian Van Hove (UGent, Belgium) -
Overview of Imaging Modalities
12h30 - 14h00 | Lunch Break
14h00 - 15h30 | Lecture: Prof. Dr. Serge Muyldermans (VUB, Belgium) -
Nanobody Discovery and Biotechnological Applications
15h30 - 15h45 | Coffee Break
15h45 - 17h00 | Lecture: Dr. Marleen Keyaerts (VUB/UZ Brussel, Belgium) -
Overview of Clinical Nuclear Medicine
Day | 09h00 - 10h30 | Welcome & Round Table Introduction
2 10h00 - 11h30 | Lecture: Prof. Dr. Nick Devoogdt (VUB, Belgium) - Imaging
with Nanobodies in Preclinical Models
11h30 - 13h00 | Lunch Break
13h00 - 14h30 | Lecture: Dr. Catarina Xavier (VUB, Belgium) - Radiolabeling
Techniques for Nanobodies
14h30 - 14h45 | Coffee Break
14h45 - 16h15 | Lecture: Dr. Matthias D’huyvetter (VUB, Belgium) -
Targeted Radionuclide Therapy: Nanobodies as an Example
16h30 Social Event in the evening: Brussels Visit & Dinner
Day | 09h00 - 10h30 | Lecture: Dr. Sophie Hernot (VUB, Belgium) - Fluorescence
3 and Cardiovascular Applications of Nanobodies
10h30 - 10h45 | Coffee Break
10h45 - 12h15 | Lecture: Dr. Chloé Ackaert (VUB, Belgium) -
Immunogenicity of Proteins and Nanobodies
12h15 - 13h30 | Lunch Break
13h30 - 17h00 | Hands-on Session
Day | 09h00 - 10h30 | Lecture: Dr. Marleen Keyaerts (VUB/UZ Brussel, Belgium) -
4 Clinical Translation of Nanobody-tracers
10h30 - 10h45 | Coffee Break
10h45 - 12h15 | Lecture: Prof. Dr. Geert Reas (VUB/VIB, Belgium) -
Intellectual Property of Biologics
12h15 - 13h30 | Lunch Break
13h30 - 17h00 | Hands-on Session
Day | 09h00 - 10h30 | Lecture: Dr. Géraldine Gebhart & Dr. Zéna Wimana (Bordet
5 Institute Brussels, Belgium) - Clinical Immuno-PET
10h30 - 10h45 | Coffee Break
10h45 - 12h15 | Lecture: Prof. Dr. Stire Lindegren & Prof. Dr. Tom Back
(Gothenburg University, Sweden) - Alpha-therapy with
Antibodies
12h15 - 16h00 | Round Table Discussion & Workshop Evaluation

17




x = URERHES AR g/ MESEAE

Analysis of Nanobody In | Nanobody Lead Visit and Operations of | Optical Imaging in Mice | Nanobody

vivo Biodistribution | Selection Analysis | Hospital Nuclear Radiochemistry

Data in Mice Medicine Department Techniques

Or. Matthios D'huyvetter | Prof. Dr. Nick Devoogdt | Dr. Marleen Keyaerts Prof. Dr. Sophie Hernat | Dr. Catarina Kavier

Ahmet Krasnigi Janik Pyttemans Prof. Dr. Vicky Caveliers

Cindy Peleman D llse Vaneycken
Capacity N 8 lax 8
Wednesday | - Sandra van Tiel - Yannick Regin - Wendy Kucma - Loontje Da Couninck | - Danielle Berus
hpril 77| - Poter Covans - Mai-Hui Wang - Hlina Van Langanhovan | - Marius Regin - (larita Saldarriaga Vargas
06 - Bart Roman - Nahid Yusufi - Nicky Hoevanaars - Joka Mertens - Joao Corraa

- Lara Struclans - Pedro Mendas Fontas - Stijn Piessens - Inga Hansan

- Kim De Vairman - Marti Boss - Jordy Stichalmans

- Magdalona Bialkowska | - Mijke Buitinga - Mahammad Zourob

- Florent Antoni

Thursday | - Wendy Kucma - Laantjo D Counick - Marius Regin - Jordy Stichalmans
Aprl 28 |-Elina Van Langanfioven | - Nicky Hoavenaars - Joka Hlortens - Mohammad Zourob
06 - Daniclla Berus - Joao Corraa - Stiin Piassans - Sandra van Tiel

- Clarita Saldarriaga Vargas | - Ing Hanson - Magdalona Bialkoviska - Yannick Ragin

- Mai-Hui Wang - Bart Roman - Mijka Buitinga

- ahid Ysuf - Lara Strualons - Florant Antoni

- Padro Mendas Fontes | - Kim Da Veirman

- Marti Boss
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Tissue Lu-177 DTPA Her 2 Lu-177
nanobody DTPA-Trastuzumab
Lung 0.01 1.55
Heart 0.01 0.98
Liver 0.05 1.72
Kidney 0.90 1.22
Spleen 0.02 1.60
Muscle 0.01 0.41
Bone 0.03 0.77
Intestine 0.01 0.44
Blood 0.001 4.18
Tumor 0.90 5.55
Dosimetry data are expressed as Gy/MBq
Ref:

D'Huyvetter M, Vincke C, Xavier C, Aerts A, Impens N, Baatout S, De Raeve
H, Muyldermans S, Caveliers V, Devoogdt N, Lahoutte T. Targeted
Radionuclide Therapy with A *’’Lu-labeled Anti-HER2

Nanobody. Theranostics 2014; 4(7):708-720. doi:10.7150/thno.8156.
Available from http://www.thno.org/v04p0708.htm
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Generic name Indications Target
Rituximab CLL, NHL CD20 (B cells)
lbritumomab tiuxetan; NHL CD20 (B cells)
90Y-ibritumomab tiuxetan
Tositumomab; 13!-tositumomab | NHL CD20 (B cells)
Ofatumumab CLL CD20 (B cells)
Obinutuzumab CLL CD20 (B cells)
Brentuximab vedotin HL, anaplastic CD30 (B & T cells)
large cell
lymphoma
Gemtuzumab ozogamicin AML CD33 (myeloid cells)
Alemtuzumab CLL CD52 (lymphoid cells)

AML: acute myeloid leukemia; CLL: chronic lymphocytic leukemia; HL: hodgkin lymphoma; NHL: non-hodgkin lymphoma

ERARE:2016 455 =R PURS IS 2 By T AR &
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Generic name Indications Target
Trastuzumab Breast cancer HER2 (tumor cell membrane)
Pertuzumab Breast cancer HER2 (tumor cell membrane)

Trastuzumab emtansine

Breast cancer

HER2 (tumor cell membrane)

Panitumumab

Colorectal cancer

EGFR(tumor cell membrane)

Cetuximab Colorectal cancer EGFR (tumor cell membrane)
Head and neck cancer

Ipilimumab Melanoma CTLA-4 (T-cells)

Pembrolizumab Melanoma PD-1 (T cells)

MPDL3280A

Bladder cancer

PDL1 (tumor cell membrane)

Ramucirumab

Gastric cancer

VEGFR2 (microenvironment)

Bevacizumab

Colorectal cancer

Renal cell cancer

Non small cell lung
cancer

VEGF (microenvironment)

BERRE:2016 55 — e fifeia s Bl oy T e T &
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50 mg trastuzumab needed if patients
off trastuzumab

Type of probelPET or SPECT Probe Patient population (N)  |Optimal timing[Findings Reference
(dose) for imaging
[ In-trastuzumab 185 Mbg with Advanced disease (10) not mentioned JAbility to predict cardiotoxicity and Behr et al.
jvariable amount of trastuzumab response to trastuzumab (2000)
[ In-trastuzumab (100-150 Mbq) |Advanced disease (15) p to 7 days after Low tumor detection rate Perik et al.

I ntact jafter the first therapeutic dose of njection No ability to predict trastuzumab- (2006)
trastuzumab induced cardiotoxicity

mMmono-
“Zr-trastuzumab (37 Mbq + either [Advanced disease (14) on/off iday 4-5 after injectionfExcellent tumor uptake Dijkers et al.

C|0na| 10 or 50 mg trastuzumab) trastuzumab therapy \Visualization of metastasis in (2010)

5 0 liver/bone/lung/ brain
antibodies

trastuzumab preceded by
trastuzumab infusion (45 mg))

months

lSome lesions only seen on & Cu-
trastuzumab PET
15 mg cold trastuzumab needed

“Cu-trastuzumab Farly and advanced disease (6) M8 hours after No “cold" trastuzumab used [Tamura et al.
130 Mbg, no unlabeled njection Suboptimal visualisation of liver lesions [(2013)
trastuzumab) Primary tumors/Brain metastasis seen
=
Cu-trastuzumab jrdvanced disease (8) off 18 hours after Mapping of lesions very close to the onelMortimer et al)
364-512 MBqg, 5 mg of ftrastuzumab therapy for 2 4 njection obtained by 8F-FDG-PET (2014)

Affibody
molecules

In or ~ Ga-labeled ABY-002 (80—
90 mg with activity ranging from
110-267 Mboq)

jAdvanced disease (3) on/off
trastuzumab therapy

B hours after injection|

High detection rate of known lesion on
[“F-FDG-PET

High level of liver/kidney uptake is
problematic

Baum et al.
(2010)

[ In-ABY-025 (100 mg with a mean
activity of 142.6 MBq, range, 131-
154 MBg)

jAdvanced disease (7) with 5 HER2+
land 2 HER2 - tumors;
kome on trastuzumab therapy

24 hours after
njection

Visualization of HER2 metastasis
including liver/brain

Strensen et al.
(2014)

Nano-
bodies

Ga-antiHER2-nanobody (53-174
Mbg-average 107Mbqg)

Early and advanced disease

B0 min after injection
allowing decreased
uptake in the liver)

No adverse reaction to tracer

4.6 mSv/patient

Critical organ: bladder

\Visualization of HER2 metastasis
Primary lesions were more variable in
fracer accumulation.

Keyaerts et al.
(2015)

BRI 2016 F£55 =
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Workshop CERTIFICATE

Vrije Universitet Brusse!

1, undersigned, Nick Devoogdt, Coordinator of the training course
Immuno-Imaging and Molecular Therapy
held at Brussels, Belgium
certify that
MEI-HUI WANG
has attended the 5-day EMIDS Workshop

from 25/04/2016 to 29/04/2016
(ie. 30 hours)

Contents : - DI : Wefcome by Nick Devoogdt (30min)
- D1 : Dos and bon's in tmmunotracer Design by Nick Devoogdt (1h30)
- D1 : Overview of Imaging Modalities by Christian Van Hove (1h30)
- DI : Nanobody Discovery and Biotechnological Applications by Serge Muyldermans (1h30)
- D1 :vav:bwofCtimz:alMxvearMedfdnebyMaﬂemKeyaerts(th)
- D2 : Welcome and Round-Table Introduction by Nick Devoogdt (1h)
- D2 : Imaging with Nanabodles in Preclinical Models by Nick Devoogdt (1h30)
- D2 : Radiolabeling Technigues for Nanobodies by Catarina Xavier {1h30)
- D2 : Targeted Radionuciide Therapy: Nanobodies as an Example by Matthias Dhuyvetter (1h30)
- D3 : Fluorescence and Cardiovascular Applications of Nanobodies by Sophle Hernot (1h30)
- D3 : Immunogenicity of Proteins and Nanobodies by Chioé Ackaert (1h30)
- D3 : Hands-on Session (4h)
- D4 : Clinical Transtation of Nanobody Tracers by Marleen Keyaerts (1h30)
- D4 : Intellectual Property of Biologics by Geert Raes (1h30)
- D4 ! Hands-on Session (4h)
- D5 : Qlinical Immuno-PET by Géraldine Gebhart and Zéna Wimana (1h30)
- D5 : Alpha-Therapy with Antibodies by Stiire Lindegren (1h30)
- D5 : Round Table Discussion (1h)

Done at Brussels, on 29/04/2016
Course leader :

B, Vrije
Universiteit
Brussel
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‘ Immiunization of a dromedary with antigen source ‘

‘ Flow cytometry analysis of serum g6 subelasses ‘

‘ Generation af immune Nb phage display liorary ‘

‘ Biopanning an recombinant VCAML proteins ‘

‘ Crude slectio of anVCAME N i LSAand FACS \

Ichuaneana\grsis

‘ Nb expression and purification ‘

‘ Characterization af nanlabeled Nbs H Characterization of technetium-39m- (99m-Tc| labeled Nbs
‘ Recognition of VCAM1-pasitive cells in flow cytometry H 99m-Te-Labeling efficiency
Recognitian of VCAM1-Ft and ‘.!CL\Ml-puswc cellsin ELISA H Saturation bindin! on VCAM1-pasitive cells
Affinities IorVCAMl-|Fc protein via SPR Biodistribution studies iL ApoE-deficient [ApoE'-"] mice
Affinities 1oerAM1p!}sin'vE cells in ELISA H Tumor uptake inV[AM|l-posiwe tumar-bearing mice

Selection of 2 anti-VCAM1 Nos

‘ Determination of melting temperature ‘

‘ Blood clearance in naive mice ‘

‘ Biodistribution and tumor uptake in different tumar models via pinhole SPECT/CT ‘

Final selection af anti-VCAMY Nb for phase | clinical trial for the detection of
atherosclerofic lesions the via nonvinvasive imaging

B 2~ ICMI ¥}5§8¢ anti-VCAM-1 Z i E55HE
Courtesy from Prof Dick Devoogdt
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Courtesy from Prof Serge Muyldermans
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@' + 2-mercaptoethylamine
— —y ——

@

+ maleimide-functionalized
chelating agent

+ radiolabel

B 4 - C-terminal Efr##%E Maleimide-functionalized chelating agent BYSRHEE

Ref:

Sam Massa, Catarina Xavier, Jens De Vos, Vicky Caveliers, Tony Lahoutte, Serge
Muyldermans, and Nick Devoogdt. Site-Specific Labeling of Cysteine-Tagged Camelid
Single-Domain Antibody-Fragments for Use in Molecular Imaging. Bioconjugate

Chem., 2014, 25 (5), pp 979-988.
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Ref:

Sam Massa, Niravkumar Vikani, Cecilia Betti, Steven Ballet, Saskia VVanderhaegen, Jan
Steyaert, Benedicte Descamps, Christian VVanhove, Anton Bunschoten, Fijs W. B. van
Leeuwen, Sophie Hernot, Vicky Caveliers, Tony Lahoutte, Serge Muyldermans, Catarina
Xavier and Nick Devoogdt. Sortase A-mediated site-specific labeling of camelid
single-domain antibody-fragments: a versatile strategy for multiple molecular imaging
modality.Contrast Media and Molecular Imaging (2016) DOI: 10.1002/cmmi.1696.
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Preclinical SPECT/CT imaging, 1h p.i. Preclinical PET/CT imaging, 1h p.i.

' Kidney _)

f \.0/‘( W

('8F]FB-2Rs15d ['*F]FB-Bcll10

99mTc-labeled HER2-nanobody '8F-labeled HER2-nanobody

B 6~ Tc-99m Her2 Z=>kPiEERN F-18 Her2 Z3kbiBmEY s E

BERRE:2016 55 = fEfiifeia s Bl T e T &
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Ref:

D'Huyvetter M, Vincke C, Xavier C, Aerts A, Impens N, Baatout S, De Raeve
H, Muyldermans S, Caveliers V, Devoogdt N, Lahoutte T. Targeted
Radionuclide Therapy with A *’’Lu-labeled Anti-HER2

Nanobody. Theranostics 2014; 4(7):708-720. doi:10.7150/thno.8156.
Available from http://www.thno.org/v04p0708.htm
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Conjugation

Labeling

0 % fo

G ¢

NH-L »

Os ,Op NH,-Lys Q/ ys Q/ NH-Lys
* ———= (CH,),Sn 211a¢/ NIS 211 p¢
pH 8.5 pH 5.5
Sn(CH,),
m-MeATE Antibody Antibody-ATE Conjugate

Astatinated Antibody

B 11 -~ Conjugation of antibody with the labeling reagent N-succinimidyl
3-(trimethylstannyl)benzoate (m-MeATE) followed by labeling of immunoconjugate
with 2At

Ref:
Kim YS, Brechbiel MW.Tumour Biol. 2012 Jun;33(3):573-90. doi:
10.1007/s13277-011-0286-y. Epub 2011 Dec 6.
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8% — ~ B AR To-OmRRE A bR HE 2 ° B(Tricarbonyl Method)

Site-specific labeling of His-tagged nanobodies with *™Tc: a practical guide

1. Materials
1.1. Preparation of ”"‘Tc-Trlcarbonyl Precursor

1.1.1. Lyophilized kit (IsoLink™, Covidien, St Louis, USA) containi.ng 4.5 mg
of sodium boranocarbonate, 2.85 mg of sodium tetraborate.10H-0, 8.5
mg of sodium tartrate.2H,0, and 7.15 mg of sodium carbonate, pH 10.5

1.1.2. Hydrochloric acid (HCl): 1 M solution in water.

1.1.3. **Mo/""Tc generator (Drytec; GE Healthcare).

1.1.4. Well-ventilated hoods and lead shielding.

1.1.5. Water bath or dry heating block.

1.2. Assessment of Radiochemical Purity of ”‘"Tc-‘l’rlcarbonyl Precursor
1.2.1. HPLC-system equipped with a radiometric y-detector.
1.2.2. HPLC column: PLRP-S 300 A, 5 um, 250 x 4.6 mm (Agilent).
1.2.3. HPLC solvents: 0.1% trifluoracetic acid (TFA) in H,0 (solvent A) and

0.1% TFA in acetonitrile (solvent B).

1.3. Labeling of His-Tagged Nanobodies with *™Tc-Tricarbonyl
1.3.1. Nanobody: 1 mg/mlin phosphate buffered saline pH 7.4, (see note 1)
13.2. fac-[*"Te(CO)s(H,04s]": 0.74 - 3.7 GBa/ml
1.3.3. Eppendorf tubes,

1.3.4. Water bath/dry bath (52 °C)
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1.3.5. Disposable NAP-5 columns (GE Healthcare, Diegem, Belgium),
equilibrated with 10 mL phosphate buffered saline pH 7.4.

1.3.6. 0.22 pm Millipore filter (4 mm, Millipore, Brussels, Belgium).

1.4. Assessment of Radiochemical Purity of “"Tc-Tricarbonyl Nanobody by
HPLC analysis
14.1. HPLC-system equipped with a UV and a radiometric y-detector
connected in series.
14.1.1.  HPLC column: PLRP-S 300 A, 5 um, 250 x 4.6 mm (Agilent).
1.4.1.2.  HPLC solvents; 0.1% trifluoracetic acid (TFA) in H,0 (solvent A)

and 0.1% TFA Acetonitrile (solvent B).

1.5. Assessment of Radiochemical Purity of ”"‘Tc-Trlcarbonyl Nanobody by ITLC
analysis
1.5.1. Instant Thin Layer Chromatography (ITLC) using silica gel impregnated
glass fiber sheets (Pall Corporation, Life Sciences).
1.5.2. ITLC eluent: acetone.

1.5.3. Dose calibrator or gamma counter.

2. Methods
2.1. Preparation of **™Tc-Tricarbonyl Precursor
2.1.1. Add 1-1.5 mL of the ®™Tc0, solution (**Mo/*Tc generator eluate;
0.74 - 3.7 GBq) to the IsoLink™ kit,

2.1.2. Incubate the mixture at 100 *C for 20 min.
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2.1.3. Cool the reaction mixture in water.

2.1.4. Add HCl 1 M until pH 6.5-7.4

2.2. Assessment of Radiochemical Purity of *"Tc-Tricarbon yl Precursor

2.2.1. For HPLC analysis, inject **"Tc-Tricarbonyl {5-10 uCi) into the injection
loop. Run the following HPLC gradient, at 1 mL/min:

- 0-5 min: 25% solvent B; 5 - 7 min: linear gradient of 25% to 34% solvent B

i 7= 10 min: linear gradient of 34% to 100% solvent B; 10 - 25 min: 100%

solvent B.

2.2.2. The **™Tc-tricarbonyl precursor shows a retention time of § - 6
min, whereas unreacted **"TcO, shows a retention time of 4 min.

Typical purity of [**™T¢{CO)s(H.0)s]* (*Te-tricarbonyl) is > 95 %.

2.3. Labeling of His-Tagged Nanobodies with **™Tc-Tricarbonyl

2.3.1. Mix 50 uL (S0 ug; 1 mg/mL) of purified nanobody with 500 ul of fac-
(P Te(CO)s(H:0)s]° at pH 7.4,

2.3.2. Incubate at 52 °C for 60 - 90 min (see note 2).

2.3.3. Separate the labeled nanobody from free #™c-Tricarbonyl and
P Tc0s by gel filtration methods such as the NAP-5 column using
phosphate buffered saline (see note 3).

2.3.4. Pass the purified solution through a 0.22 pm Millipore filter to
eliminate possible aggregates.

2.3.5. Evaluate radiochemical purity by RP-HPLC {see 2.4) and/or by iTLC

(see 2.5). See note 4.
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2.4. Assessment of Radiochemical Purity of **"Tc-Tricarbonyl Nanobody
HPLC analysis

2.4.1. Inject “"Tc-Tricarbonyl Nanobody (3 - 10 uCi) into the injection loop.
Run the following HPLC gradient, at 1 mL/min:

2411 The ™ Te-Tricarbonyl Nanobody shows a retention time of
about 13 min. The *"Tc-tricarbonyl precursor shows a retention
time of 5- 6 min, and **"TcO, has a retention time of 4 min.

2.5. ITLC analysis

2.5.1. Spot 2 ul of Qth-Trlcarbonyl Nanobody solution on a 10mm x 100
mm silica gel impregnated glass fiber sheet.

2.5.2. Develop the chromatogram in acetone.

2.5.3. Analyze the distribution of radioactivity by scanning with a v-radiation
TLC scanner or counting the strip cut in 3 parts (application point,
middle, solvent front) in a dose calibrator or gamma counter. The *™Tc-
Tricarbonyl precursor and the **"TcO. reveal a Rf (retention factor) of 1

and **"Tc-Tricarbonyl-nanobody a Rf of 0.

3. Notes
3.1. The nanobody solution should be free of imidazole as this substance will
interfere with the labeling procedure.
3.2. Temperature of incubation depends on the thermostability of the
Nanobody, if possible always determine the melting temperature (Tm) of

Nanobody to be labeled,
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3.3.If the labeled Nanobody is more lipophilic, there might be some *"Tc-
Tricarbonyl nanobody activity sticking on the NAP-5 column.

3.4. Radiochemical purity before gel fitration, as determined by either method,
usually ranges from S0 to 98 %, and depends on protein concentration. At
0.1 mg/mL final concentration, labeling will be complete after 60 min. After
gel filtration and microfiltration, radiochemical purity should be >98% before

in vivo assessment.
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Date:

Nb: (clone, mw, coupling date and fraction, concentration)

Labeling conditions:
ulNb (@
ul ™ Tc(CO)(H,0)a]

*™T¢ labeling

mg/ml); moles =

Bk — ~ B AR Te-909m B S HTRE R B 78 1 R

(MW = 13452.9 g/mol)

Final concentration:
Activity: mCi/MBg
pH:

Reaction time:

Temperature:

M Nb in

p! total reaction volume

ITLC  AP:

SF:

-> labeling yield:

NAP-5 buffer exchange and purification

Activity before:
Remain in eppendorf:
Remain on NAP-5:
Eluate:

0.22 pm filtration
Remain on filter:
After filtration:
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Quality Control:

ITLC (before Purification)
AP:
M:
SF: - labeling yield:

ITLC (after Purification)
AP:

M:
SF: RCP:

RP-HPLC (after Purification)

Radiochemical purity =

Calculate Radiochemical Yield
Radiochemical yield = % (Activity of Purified product/Activity at starting of reaction)

Non-decay corrected (not taking into account the decay of “8mre)
Decay corrected {taking into account the decay of " Tc)

A = Ao‘e‘kt

t = time in seconds

99m-|-c

t1/2=In2/A

11/2 =6*60%60 = 21600 s

A=321E-055-1
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Simple Radioactive Decay: Half-life and Decay Constant

Radioactive decay is a random process. As such, one cannot state with certainty when
an unstable nuclide will decay. The probability that an atom will decay during the
time d7 is given by kdz where & is the constant of proportionality known as the decay
constant. In a system where there are N(0) atoms present initially, the number of
atoms decaying in time df is given by —dN = kNdt. In the limit of very small time
intervals, this can be expressed as

— = —kN.
dr

Integration with respect to time gives the number of atoms present at any time ¢, i.e.
N(t) = N()e™

The half-life, 7, is used to denote the time at which the number of atoms has decreased
to half the initial value, i.e. + = e %7, Hence the half-life is related to the decay

constant through the relation
In2 _ 0.693

T =R —

k k

Activity
The number of decays per unit time interval, i.e. the activity A, is defined by

A=—— =kN.
dt
It should be noted in this definition that it is assumed that N is decreasing due to
decay. In general the rate equation contains a term for decay (removal) to the daughter
and in-growth (production) from the parent, i.e.

kparent k
Nparent —> N —> Ndanghter

for which the rate equation becomes

d_N‘ = —kN + kparenl Nparem .

dr
A situation could arise in which kN = Kparent Vparent and thus N is constant, i.e.
dN/dt = 0. Clearly the activity is not zero. In the definition of A above only decay
is considered. In the general case where decay and growth occur, A is given by
A = kN. Hence A is the number of disintegrations per second even though N may
be constant. The unit of activity is the Becquerel, i.e. 1 Bq = 1 disintegration per
second.
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4.2 Law and Energy of Radioactive Decay

Radioactive decay follows the laws of statistics. If a sufficiently great number of
radioactive atoms are observed for a sufficiently long time, the Jaw of radivactive
decay is found to be

——= AN (4.1)

where N is the number of atoms of a certain radionuclide, —d N /d is the disintegra-
tion rate, and / is the disintegration or decay constant (dimension s™'). It is a meas-
ure of the probability of radioactive decay. The law of radiocactive decay describes
the kinetics of the reaction

A—=B+x+AE (4.2)

where A denotes the radioactive mother nuclide, B the daughter nuclide, x the par-
ticle emitted and AE the energy set free by the decay process, which is 2lso called the
Q-value, Eq. (4.2) represents a first-order reaction and is in the present case a mono-
nuclear reaction.

Radioactive decay is only possible if AE > 0. AE can be determined by com-
parison of the masses. According to the relation found by Einstein {eq. (2.8)),

AE=AMc* = {Ma — (Mz + Mx)]tz 4.3)

By calculation of A it can be decided whether a decay process is possible or not.
Even if AE > 0, the question of the probability of a radioactive decay process is
etill open. It can only be answered if the energy barrier is known The anergetics of
radioactive decay are plotted schematically in Fig. 4.1. The energies of the mother
nuclide and the products of the mononuclear reaction differ by AE. But the nuclide
A has to surmount an energy barrier with the threshold energy Eg. The nuclide may
occupy discrete energy levels above ground level. However, only if its excitation

4‘ excied state of
maclide A

Enargy

Figure 4.1, Energy barrier of radicactive decay
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energy is high enough can decay occur. The energy barrier must either be sur-
mounted or crossed by quantum mechanical tunnelling.

The law governing radioactive decay (eq. (4.1)) is analoguous to that of first-order
chemical kinetics. The excited state on top of the energy barrier corresponds to the
activated complex, and £ is equivalent to the activation energy.

Integration of eq. (4.1) gives

N = Noc™* (4.4)

where Nj is the number of radioactive atoms at the time ¢ = 0. Instead of the decay
constant 4, the half-life ¢, > is frequently used. This is the time after which half the
radioactive atoms have decayed: N = Ny /2, Introducing the half-life 1, ; in eq.(4.4),
it follows that

In2 0.693
i Sy P T (4.5}
and
1\
N=N, (5) 46)

From this equation it is seen immediately that the number of radioactive atoms has
decreased to one-half after one half-life, to 1/128 (less than 1%) after 7 half-lives, and
to 1/1024 (about 0.1%) after 10 half-lives. If the time ¢ is small compared with the
half-life of the radionuclide {1 « 112}, the following approximation formula may be
used:

2
c"“:]-,{;.;.%_...
b t (In2)* /¢ \?
_:-(1nz)(ﬁ)+ ; (E}Z) 2 1)

The average lifetime 7 15 obtained by the usual calculation of an average value

ek ] s
r_NJ:th—Lc de== (4.8)

From eq. (4.4) it follows that after the average lifetime r the number of radicactive
atoms has decreased from Ny to Ny /e (r = 1),/ (In2)).

Generally, the half-life of a radionuclide docs not depend on pressure, tempera-
ture, state of matter or chemical bonding. However, in some special cases in which
low-energy transitions occur, these parameters have been found to have a small
influence (section 10.2),
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The activity A of a radionuclide is given by its disintegration rate;

The dimension is s~', and the unit is called becquerel (Bg):1Bg = 157!, An older
unit is the curie (Ci). It is still used sometimes, related to the activity of 1g of
26Ra. and defined as 1 Ci = 3.700 - 10'°5~! = 37 GBq. Smaller units are 1 milli-
curie (mCi) = 37 MBq, 1 microcurie (pCi) =37kBqg, 1 nanocurie (nCi) = 37Bq,
and 1 picocurie (pCi) =0.37Bq. 1 Ci is a rather high activity which cannot be
handied directly but needs special installations, such as hot cells. Activities of the
order of szveral mCi are applied in medicine for diagnostic purposes, activities
of the order of 1 pCi are usually sufficient for the investigation of the behaviour
of radionuclides, and activities of the order of 1 nCi are measurable without
special efforts.

As the activity 4 is proportional to the number A of radioactive atoms, the expo-
nential law, eq. (4.4), holds also for the activity:

A= Ape™ (4.10)

The mass m of the radioactive atoms can be calculated from their number N and
their activity 4:

N-M_A-M_AM,
Nay _ Nagh  Npgm2 7

m=

(4.11)

where M is the nuclide mass and Na, is Avogadro’s number (6.022 - 10%),

In laboratory experiments with radionuclides, knowledge of the mass of the
radicactive substances is very important. For example, the mass of 1| MBq of *P
(t,2 = 143 d) is only about 10~'° g, and that of 1MBq of =T¢ (t, = 6.0h) is only
about § - 10~'2 g. If there is no carrier present in the form of a large excess of inactive
atoms of the same element in the same chemical state, these small amounts of radio-
nuclides may easily be lost, for instance by adsorption on the walls, Whereas in the
case of radioisotopes of stable clements the condition of the presence of carriers
is often fulfilled due to the ubiquity of most stable clements, it is not fulfilled in
case of short-lived isotopes of radicelements, and extraordinary behaviour may be
observed (section 13.3). '

The ratio of the activity to the total mass m of the element (the sum of radioactive
and stable isotopes) is called the specific activity 4,:

A=2Ba/d (412)
Sometimes high or well-defined specific activities are required, for instance in the

case of the application of radionuclides or labelled compounds in medicine, or as
tracers in other fields of research.
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Basic SOP AMIDE Milabs SPECT-CT images

1) Import SPECT:

File -> import file (specify) -> NIFTI via (X)MedCon -> open SPECT
image ( = for example: SPECT_REG_2016000209_v02ss2it4-0-ac.nii)

Remark: A window with a warning will appear. Just click OK.
2) Import CT:

File -> import file (specify) -> NIFTI via (X)MedCon -> open CT image
( = for example: CT 2016000209.nii)

Remark: A window with a warning will appear. Just click OK.

3) Right mouse click on the SPECT (white frame left):
Basic info

* Data Set Name: Here you can change the SPECT name

* Interpolation Type: 2° type

* Conversion Type — Direct — Scaling Factor: 1
Colormap/Treshhold

* Here you can change the scale and its color

Remark: Never rotate the SPECT image in the rotate window of the
SPECT. If you do so, you will only rotate the SPECT image and you will
lose your fusion with the CT. If you still did it, you will have to redo the
whole procedure to have your fusion again

4) Right mouse click on CT(white frame left):
Basic info

* Data Set Name: Here you can change the CT name

* Interpolation Type: 2° type

* Conversion Type — Direct — Scaling Factor: 1
Colormap/Treshhold

* Here you can change the scale and its color

Remark: Never rotate the CT image in the rotate window of the CT. If
you do so, you will only rotate the CT image and you will lose your
fusion with the SPECT. If you still did it, you will have to redo the whole
procedure to have your fusion again.
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5) Orientatation
Right mouse click on “Study” (white frame left):
Basic info:
* Name: Here you can change the name of the whole image (this
name will then be used when you save your image)
Rotate:
* Rotate the image with the transverse cursor until the spine of the
animal is at the bottom on the transverse image, if this is not yet
the case.

6) Drawing ROI’s:

* Edit -> Add ROI -> ellipsoid

* A window appears where in you have to give a name to your ROI

* Draw a ROI on the desired area of the image

* A window appears where you can fill in the size of the ROI (this
can also be changed later on if you do right mouse click on the
name of the ROI in the white frame on the left of the image)

* Adjusting ROI: orientation, size,... (if you place your mouse on the
ROl in the image, you can see below in the white frame left of the
image, what you can do with it)

=> To make several ROI's, just apply the protocol above again

7) Calculate ROI statistics:

* Click on the name of the CT (white window left) so that the CT
image isn’t shown anymore (if you do not do that, you will get also
the statistics of the CT image which you don’t need for SPECT
analyses)

* Tools -> Calculate ROI Statistics

* A window appears:

- Select: On selected data sets, selected ROIS
- Chose: Calculate over all voxels (normal) (unless you
want to use a threshold)
- Execute
* A window appears with all your statistics of your ROI("s)
= Save as -> name.xls instead of name.tsv -> Ok

8) Save image:
File -> Save as (uses the name you chose in point 5, but you can still
change it if necessary, just save it as xif)
If you want to reopen your saved image: File -> Open -> xif file
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Basic SOP AMIDE Siemens SPECT-CT images

1) Import SPECT:

File -> import file (guess) -> open SPECT image ( = for example:
2013000685_3phos_nuac_sc3 phorbit 225 mmRoR_sensmap 1.5 4 5 16_0.5_

1000_1.5_ 0 0_1_1_685_764-764-1256 26954.h33)

Remark: Open the .h33 file and not the .i33, but the .h33 and .i33 have to be in
the same folder.

2) Import CT:

File -> import file (guess) -> open CT image ( = for example: 685 764-764-
1256.h33)

Remark: Open the .h33 file and not the .i33, but the .h33 and .i33 have to be in
the same folder.

3) Right mouse click on the SPECT (white frame left):
Basic info
* Data Set Name: Here you can change the SPECT name
* Interpolation Type: 2° type
* Conversion Type — Direct - Scaling Factor: Chose the scaling factor that
suits your scans (see scaling factor file)

Colormap/Treshhold
* Here you can change the scale and its color

Remark: Never rotate the SPECT image in the rotate window of the SPECT. If
you do so, you will only rotate the SPECT image and you will lose your fusion
with the CT. If you still did it, you will have to redo the whole procedure to have
your fusion again

4) Right mouse click on CT(white frame left):
Basic info

* Data Set Name: Here you can change the CT name

* Interpolation Type: 2° type

* Conversion Type — Direct — Scaling Factor: 1|

Colormap/Treshhold
* Here you can change the scale and its color

Remark: Never rotate the CT image in the rotate window of the CT. If you do so,
you will only rotate the CT image and you will lose your fusion with the SPECT.

[f you still did it, you will have to redo the whole procedure to have your fusion
again.
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5)

Orientatation

Right mouse click on “Study” (white frame left):
Basic info:

Name: Here you can change the name of the whole image (this name will
then be used when you save your image)

Rotate:

7

Y: Click on “invert axis”

If the image is upside down -> rotate the image with the coronal cursor
until the image is the right way up

Rotate the image with the transverse cursor until the spine of the animal is
at the bottom on the transverse image

Drawing ROI’s:
Edit -> Add ROI -> ellipsoid
A window appears where in you have to give a name to your ROI
Draw a ROI on the desired area of the image
A window appears where you can fill in the size of the ROI (this can also
be changed later on if you do right mouse click on the name of the ROI in
the white frame on the left of the image)
Adjusting ROI: orientation, size,... (if you place your mouse on the ROI in
the image, you can see below in the white frame left of the image, what
you can do with it)

=> To make several ROI’s, just apply the protocol above again

Calculate ROI statistics:
Click on the name of the CT (white window left) so that the CT image
isn’t shown anymore (if you do not do that, you will get also the statistics
of the CT image which you don’t need for SPECT analyses)
Tools -> Calculate ROI Statistics
A window appears:
- Select: On selected data sets, selected ROIS
- Chose: Calculate over all voxels (normal) (unless you want to
use a threshold)
- Execute
A window appears with all your statistics of your ROI(‘s)
=>» Save as -> name.xls instead of name.tsv -> Ok

8) Save image:
File -> Save as (uses the name you chose in point 5, but you can still change it if
necessary, just save it as .xif)
[f you want to reopen your saved image: File -> Open -> xif file
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